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Circuit I lab 
This is the first of three labs on basic semiconductor components. You will study semiconductor char-
acteristics and some of their applications, leading up to the design and construction of a differential 
amplifier.   
 
This lab studies diodes. You will find the relation between the voltage and current in a diode, and 
study temperature effects, rectification, nonlinear phenomena, and frequency doubling.   
 
Before coming to class complete this list of tasks: 

• Completely read the Lab Write-up 
• Answer the pre-lab questions utilizing the references and the write-up 
• Perform any circuit calculations or anything that can be done outside of lab. 
• Plan out how to perform Lab tasks. 

 
Pre-lab questions:  
 
1. In a few sentences, explain what diodes are and how they are useful. 
2. Show that the –1 term in Eq. (1) may be neglected for typical operating parameters  

(V > 0.1 V, kT ≈ 1/40 eV, Isat = 10−9 A).  
3. Why is there a ripple on top of the DC voltage output by the circuit in 4.8?  
4. What is a load line used for?  What are the relative advantages of graphical and iterative analy-

sis? 
 

 
Disclaimer: Please keep in mind that this lab is one of the most analysis & plotting intensive labs. 
Do not leave your analysis section to the last minute. Also, using a computer to do the analysis is 
much easier & quicker; so, bring a storage device to class or alternatively e-mail yourself the data 
files from the diode characteristic traces found by the Curve Tracer so you will have access to them 
both at your lab station and home. Excel is a powerful timesaver when graphing similar data sets 
mulitiple times. A final safety tip, Do not touch components while power is on only after they have 
had a chance to cool off . This is especially true if the circuit has been build wrong. 
 
The LEDs will burn out if you hook them directly to the 5V 
power supplies without a current limiting resistor. 
NOTE: This lab uses liquid nitrogen. 
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Background 
 
Diodes and pn Junctions 
Diodes and transistors are made from semiconducting materials: typically crystalline silicon. Pure 
silicon has few free electrons and is quite resistive. To increase its conductivity, the silicon is nor-
mally “doped”1 with other elements. Some dopants, like phosphor, arsenic and antimony, easily give 
up one of their electrons to the now impure silicon.2 As these donated electrons are free to move 
about the silicon, its conductivity increases dramatically.3  
Other dopants, like boron, indium and aluminum, grab electrons from the surrounding silicon at-
oms, leaving positively charged silicon ions behind. In turn, these now positive silicon ions try to 
lessen their charge by grabbing electrons from their neighbors…the net result is that there are re-
gions of “positiveness” floating around the crystal lattice. Such “absences of electrons” are called 
holes. Amazingly, holes behave almost exactly like positively charged electrons; they move, respond 
to electric fields, and appear to have a mass close to the electron mass. 
A doped semiconductor with more mobile electrons than holes is called an “n-type” semiconductor; 
conversely, a doped semiconductor with more holes than mobile electrons is called a “p-type” semi-
conductor.  
If doping’s only effect was to increase semiconductor conductivity, semiconductors would be obscure, 
little-used materials. The utility of semiconductors comes from the remarkable effects of placing p 
and n-type materials next to each other. Such juxtapositions are called “pn” junctions. An isolated pn 
junction makes a semiconductor diode. Other semiconductor components are made from more com-
plicated arrangements; bipolar npn transistors, for example, are made by sandwiching a p layer in 
between two n layers, hence the name npn. 
The current through an ideal pn junction is given by the diode equation.   
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where V is the voltage drop across the junction, isat is a constant called the saturation current and 
depends on the temperature and the particular geometry and material of the junction, 
e = 1.6 × 10−19 C is the charge of an electron, k = 1.38 × 10−23 J/K is Boltzmann’s constant, and T is 
the temperature in Kelvin.4 The constant n varies between 1 and 2 depending on the particular di-
ode, but is typically equal to 2 for discrete diodes. Notice that the diode’s response is directional and 
highly nonlinear. When forward biased, (V positive) enormous currents can flow through the diode 
because of the exponential dependence of I on V. When reverse biased, (V negative), the current ap-
proaches −isat. Since isat is typically very small (picoamps are not uncommon), very little current 
flows.5 Thus the diode acts like a one-way valve; current can only flow in one direction.  
When forward biased, the positive end of the diode is called the anode, and the negative 
end is called the cathode.6 

  The triangle side is the anode and the vertical line side or bar is the cath-
ode. 
 

                                                      
1 Deliberately contaminated. 
2 Of course, dopants that have given up an electron become positively charged. The net charge re-
mains zero. 
3 Only a few dopant atoms will significantly increase silicon’s conductivity.  For example, one dopant 
atom per 100 million silicon atoms will increase pure silicon’s conductivity by approximately 105. 
4 At room temperature, kT/e ≈ 1/40. 
5 Junction imperfections in real diodes often cause the reverse biased current to be much bigger than 
−isat.  However, Eq. (1), with the ideal value of isat, is still valid in the forward region. 
6 The terms anode and cathode date from the days of vacuum tube diodes. 
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Nonlinear Circuit Equilibrium 
Unlike purely linear circuits, circuits containing nonlinear elements like diodes cannot be reduced to 
systems of linear equations. Consequently, the equilibrium voltages and currents in nonlinear cir-
cuits are much more difficult to determine. Although these equilibrium quantities can be found us-
ing complicated computer programs like PSpice, quick, approximate analysis methods are often 
useful, particularly for simple circuits. Two quick methods will be used in this course: (I) Graphical 
Analysis and (II) Iterative Analysis 
  
(I) Graphical Analysis – Load Lines 
Consider the simple circuit below which contains a voltage source Vo, resistor R and a generic 
nonlinear component with impedance Z(V), where V is the voltage across the component. 

Regardless of behavior of the nonlinear component, the 
voltage source and resistor set certain constraints7 on 
the possible equilibrium voltages and currents. For in-
stance, the current I cannot exceed Vo/R, the current that 
flows when the impedance of the nonlinear component Z 
is zero. Under these conditions, the voltage V across the 
nonlinear component is zero. Alternately, V cannot ex-
ceed the voltage of the source Vo, and this maximum 
voltage is only obtained when the impedance Z is infinite 
and I = 0.  Impedances between zero and infinity produce 

intermediate values of the current and voltage. The possible values fall on a curve given by the pa-
rametric equations I V R Z= +0 / ( )  and V ZV R Z= +0 / ( ) , where Z varies between zero and infinity.  
Eliminating Z demonstrates that the curve is actually a straight line given by the equation 

I V V V R( ) ( )= −0 .    (2) 
This equation could have been derived directly from its end points, I = Vo/R at V = 0 and I = 0 at  
V = Vo, or even more simply by computing the current through a resistor as a function of V. The line 
determined by Eq. (2) is called the load line because it is determined solely by the load (and the 
power source), not by the nonlinear component. 
 
The nonlinear component obeys its own equation, or 
“characteristic” curve IZ(V). Both the load line and the 
characteristic curve must be satisfied simultaneously. 
Consequently the equilibrium current and voltage for 
the circuit are given by the intersection of the load line 
(Eq. (2)) and the characteristic equation IZ(V). For ex-
ample, assume that the nonlinear component is a diode 
(isat = 4 ×  10−10 A) driven by a 1k resistor from a 2V bat-
tery. 
 

                                                      
7 Assume that the nonlinear device does not contain any internal power source, hence Re(Z) ≥ 0.  
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  Fig. 1: Resistor Diode Equilibrium 
 

The load line and diode, 1N4448 characteristic 
(Eq. 1) intersect, as shown to the left, at equilib-
rium voltage  
V = 0.75 V and current I = 1.25 mA. 
The equilibrium voltage across the diode is some-
times called the operating point of the circuit. 
 
 
 
 
 

(II) Iterative Analysis 
Nonlinear equilibria can also be found iteratively: by guessing an initial solution, determining the 
consequences of the guess, and then iteratively refining the guess. This method is best explained 
with an example: Using the diode circuit in Fig. 1, guess a current (say i = 5 ma), and then invert the 
diode characteristic ( )[ ]V i nkT e i i( ) ln( )= +sat 1  to find the voltage across the diode that would have 
produced this current (V = 0.81706 V). Next subtract this voltage from the battery voltage to deter-
mine the voltage across the resistor (Vo – V = 1.18294), and divide by the resistance R to refine the 
current guess (1.18294 mA). Repeat and continue iterating until the numbers converge.8 The first 
five iterations are given in the table below. 
 

Iteration Current 
  

(mA) 

Diode 
Voltage 

(V) 

Resistor 
Voltage 

(V) 
Initial Guess 5.00000 0.81706 1.18294 

1 1.18294 0.74499 1.25501 
2 1.25501 0.74795 1.25205 
3 1.25205 0.74783 1.25217 
4 1.25217 0.74783 1.25217 
5 1.25217 0.74783 1.25217 

 
Both the load line analysis and the iterative analysis yield the same values for the equilibrium volt-
age and current. [Note that the diode equation [Eq. (1)] was used in both methods. With some loss in 
precision,9 experimental data taken from an actual diode can be used instead.] 
 

                                                      
8 Be careful: iterative methods do not always converge. In fact, running the described sequence 
backwards (guess the diode voltage, calculate the current, find the resistor voltage drop, and sub-
tract from the battery voltage to refine the diode voltage guess) does not converge. Try it yourself! 
The study of the convergence of these methods is called Iterated Map Theory, and, surprisingly, is 
the basis for modern Chaos Theory. 
An animation and a Mathcad program illustrating converging and nonconverging iterative proce-
dures are available on the web and on the computer in the lab. 
9 Of course the apparent precision of the iterative method is deceptive as it relies on precise knowl-
edge of isat and n. Don’t worry; answers with accuracy's better than 10% are rarely required in elec-
tronics. 
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Perturbation Analysis 
Determining a circuit’s response to small changes in its parameters is as important as determining 
its initial equilibrium. The general subject of the response of a system to small parameter changes 
(perturbations) is called perturbation analysis. In the circuit of Fig. 1, for example, perturbation 
analysis can be used to determine the change in the diode voltage when small changes are made to 
the source voltage.   
 
(i) Graphical Perturbation Analysis 
By definition perturbation analysis considers only 
small changes to the system parameters. Conse-
quently it is both convenient and permissible to lin-
earize around the equilibrium conditions. Using the 
circuit in Fig. 1 as an example, consider a small 
change in the battery voltage of ∆Vo = +0.25 V. This 
perturbation will shift the load line upwards as 
shown to the below,10 and the intersection will shift 
concomitantly. The change in the diode voltage ∆V 
can then be read off the graph from the new intersec-
tion point. In this case, ∆V is much smaller than the change in the battery voltage ∆Vo. 
 
(ii) Small Signal Impedance Perturbation Analysis 
The above graphical procedure is completely equivalent to the following method: First calculate the 
small signal impedance Z of the nonlinear diode at its operating point. The small signal impedance 
is the reciprocal of the slope of the IV curve,   

,
I
V

Z
∂
∂

=  

at the operating point. Then use Z in a “linear” circuit analysis. Because the IV curve is not linear, Z 
must be recalculated if the voltage across the diode changes (i.e. if the operating point changes). 
 
In the lab 
(A) Forward and Reverse Diode Behavior 
 
4.1 Obtain a 1N4448 diode.11 Use a BNC cable and minigrabbers to connect the DMM to the diode. 
Set the DMM to the 2k-resistance scale; the diode symbol printed on this scale indicates that it is 
the preferred scale for diode measurements. Confirm that the diode conducts unidirectionally by 
measuring its resistance in both directions. The DMM is set up so that the red minigrabber lead is 
positively biased referenced to the black lead. Thus, for conduction, the red lead should be attached 
to the diode anode, and the black lead should be attached to the cathode. On the diode itself, the 
cathode is marked by a black band.   
 
You should find that the diode resistance is about 650Ω in the forward direction, and off scale in the 
reverse direction. Since the meter attempts to provide about 1mA of current on the 2kΩ scale, 650Ω 
corresponds to a voltage drop across the diode of about 0.65V. This voltage drop is referred to as the 
“forward voltage drop” at 1mA. 
 

                                                      
10 For graphical clarity, the slope of the linearized diode characteristic has been decreased; other-
wise ∆V would have been so small as to be unprintable. 
11  The label 1N4448 designates the type of diode. Hundreds of different types of diodes are avail-
able. Many types are made by several different manufacturers; each manufacturer certifies that 
their diode meets the industry-wide specifications. Parts with labels that begin with 1N are always 
diodes, while parts that begin with 2N are transistors, but not all diodes and transistors follow this 
naming convention. Specifications for the 1N4448 diode are given in Appendix I. 
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4.2 Obtain a plastic-stick-mounted 1N4448 diode from the laboratory staff. Repeat your measure-
ment of the forward voltage drop using the DMM. Does this diode have exactly the same forward 
voltage drop as the diode you used in part 4.1? Squeeze the diode between you fingers. The  forward 
voltage drop should change as the diode heats up to your finger temperature. What is the new value?  
For more dramatic results, dip the diode into liquid nitrogen, which you can obtain from the labora-
tory staff. What is the forward voltage drop now? Diode forward voltage drops are frequently used as 
temperature sensors. 

Figure 2 Diode Analysis 
 
DMM resistance measurements are a useful crude indicator of diode performance, and are often 
used to determine if a diode has been burnt out. However, DMM measurements are single current 
measurements, and do not determine the complete forward voltage/forward current characteristic 
curve.  The most straightforward way to obtain this curve is to measure the current while driving 
the diode with a variable voltage source.   
 
4.3 Now you will examine the Offset Adder, which is located on the breadboard box, to see how 
the Adder works. Temporarily ignore the input BNC jack. Measure the output voltage while turning 
the Offset Adjust knob. See how the voltage can be varied from approximately –12 to 12V? Try load-
ing the output with several different resistor values. Prove that the circuit is a relatively stiff (low 
output impedance) voltage source so long as the output current is kept below approximately 24mA.  

 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 

OutputOffset
AdderInput   Signal

Generator
VVin out1N4448
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10k
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4.4 Construct the circuit below. 

DMM
Current
 Meter VAdder

Offset
 

 
Vary the voltage across the diode with the offset adder. Record both the current and the voltage at 
about five points. Plot the resulting characteristic curve on linear and on log-linear paper.   
 
 
Warning: Because diodes of the same type can have significantly different characteristics, 
use the same diode for all experiments in this lab. If you need to use your diode on another 
day, mark it with a piece of tape with your name and leave it on the lab bench. 
 
Obtaining enough points to carefully characterize the diode is tedious. Moreover, the slow rate at 
which the data is collected allows the diode to significantly heat up at the high current points, dis-
turbing the measurement. A Curve Tracer is an instrument that automatically and relatively 
quickly measures characteristic curves. 
 

4.5 Use the Curve Tracer to find your diodes characteristic curve. Use the Curve Tracer   
analyze function to obtain the values of isat and the voltage coefficient. Assuming that the 
diode is at room temperature, calculate n. Plot the Curve-Tracer data, and add the points 

that you obtained in part 4.4 to the graph. (See Appendix II for operation instructions for the Curve 
Tracer & the meaning of the voltage coefficient.) 
 
4.6 Measure the reverse diode current at –12V with the circuit below.  

1M
12V 1N4448

 
Determine the current through the diode by measuring the voltage across the resistor. 
 
(B) Diode Rectifier  
Since diodes carry current only in one direction, they can be used to rectify AC signals: to turn AC 
signals into DC. In fact, diodes are sometimes called rectifiers. Rectification is very important in 
electronics because, although almost all circuits run off of DC,12 the electric company provides AC 
power. 
 

                                                      
12 Two of the few circuits that run directly on AC power are light dimmers and some electric motor 
controllers. 
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4.7 Build the half-wave rectifier circuit below. 

   5V
200Hz

1N4448

47kR V
L out

 
Using both channels of the scope, look at the voltage across the AC source and the circuit output.  
Sketch both signals, and explain the output. 
 
Rectification, as provided by the previous circuit, is only the first step in converting an AC power 
source into a DC power supply. The gross irregularities in the signal produced by the above circuit 
need to be smoothed out, typically by a large filter capacitor. 
 
4.8 Add a 1µF capacitor to your circuit. (If you use an electrolytic capacitor, make sure you 
obey the polarity markings on the capacitor body.) 

1N4448

RL 47k Vout   5V
200Hz

C
1µ

 
Make careful sketches of the output waveform. Note the amplitude of the ripple. How does it change 
when you: a) double the input frequency; b) double the filter capacitor C; c) double the load resistor 
RL?  (See analysis question 4.15) 
 
(C) Diode Equilibrium  
 
4.9 Using the same diode as before, build the circuit shown in Fig 2. Study the DC response of the 
circuit by temporarily disconnecting the signal generator. Vary Vin by turning the Offset Adjust knob 
on the Offset Adder.  What is Vout for Vin = 0.25, 0.5, 0.7, 1, and 2 VDC? Select a different resistor, 
say Rl = 1k. Again measure the output voltage for several input voltages. Using the graph of the di-
ode characteristic you obtained in question 4.5, perform a graphical load line analysis for each of the 
resistors. Do the equilibrium points predicted by the load line analysis agree with your data? (See 
Appendix III for an Excel tutorial.) 
 
(D) Small-Signal Behavior 
 
4.10 When a signal is connected to the Offset Adder’s Input BNC, the Adder’s output is the sum of 
the input signal and the internal offset set by the Offset Adjust knob. Reconnect the signal generator 
to the Offset Adder, and temporarily disconnect the resistor and diode. Examine the Offset Adder’s 
output on the scope, and play with different offsets and inputs until you understand the Offset Ad-
der’s function. (You need not record anything.) 
 



Physics 111 BSC Laboratory Lab 4 Semiconductor Diodes 

Last Revision: August 2005  Page 9 of 20 
© 2005 by the Regents of the University of California. All rights reserved. 

 
4.11 Reconnect the 10k resistor and diode to the Offset adder. (You should now be back to the cir-
cuit in Fig. 2.) Adjust the signal generator and Offset Adder to produce a 0.1 V p-p sine wave riding 
on a +1V DC offset. Sketch Vout. In contrast to the output signal produced the circuit in 4.7, the sig-
nal is not rectified, i.e. the lower half is not cut off. Explain why. 
 
4.12 What happens to the amplitude of the AC component of the output signal as you vary the DC 
offset? With the values for the DC offset used in 4.9, record the amplitude of the AC component of 
the output signal. Plot the measured data. (See analysis question 4.16 and 4.17) 
 
(E) Light Emitting Diodes (LEDs) 
LEDs are diodes made from the semiconducting material Gallium Arsenide (GaAs) rather than from 
silicon. GaAs junctions have the very useful property that they emit light when forward biased.  
 
4.13 Construct the circuit below using an LED for the diode. 

5V

100

+

 
The longer lead on the LED is the anode, and the flat on the side of the LED is on the cathode side.  
The LED should not light.  Measure the voltage across the resistor to demonstrate that no current is 
flowing.  Now swap the power supply polarity; the LED should light. Measure the voltage drop 
across the resistor and LED. Substitute 300Ω, 3k, 30k, and 300k resistors for the 100Ω resistor.  
How does the brightness of the LED change?  How does the forward voltage drop change?  Note: 
these voltage measurements can be done with either the DMM or the Scope, but you will find more 
accuracy and save time using the DMM.  

 
4.14 Find the LED’s characteristic curve using the Curve Tracer. 
 

 
 
Analysis 
 
4.15 Derive an (approximate) expression for the (peak-to-peak) amplitude of the ripple in the recti-
fier built in 4.8 as a function of the input voltage and frequency, load resistor, and filter capacitor.  
Does your model agree with your observations? 
 
4.16 Perform a graphical perturbation analysis for three of the points in exercise 4.12 to predict the 
AC amplitude of the output. To do this, use the diode characteristic curve you obtained in 4.5 and  
values of the operating point from 4.9. Remember that the DC offset is the operating point voltage & 
the 0.1 Vp–p sine wave is the perturbation. Plot the predicted data on the same graph as the data you 
measured in 4.12. 
 
4.17 Now make a new set of predictions for three of the points in exercise 4.12 by calculating the 
small signal impedance of the diode at each operating point. Use this impedance in a “linear” voltage 
divider analysis. Plot these predictions on the 4.12 graph. Show how the large-signal impedance 
would yield a voltage divider output much greater than the actual answer. 
 
 

 

Comment [DJO1]: Too time con-
suming how can we shorten this? 

Comment [DJO2]: Suggest a 
method of modeling many groups 
had problems with this 

Comment [DJO3]: Again more 
prelab instruction on small and 
large signal impedance is necessary. 
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Supplementary Problems 
(F) Zener Diode 
 

4.18 Circuits frequently require DC voltages less than the circuit power supply voltage. Such 
voltages can be obtained with voltage dividers, but dividers are not stiff and will decrease 
when heavily loaded. Furthermore, the divider voltage will follow any power supply voltage 

fluctuations. A better scheme is to use a resistor, Rs in series with a Zener diode. Use the Curve 
Tracer13 to obtain the characteristic curve of a 1N5234B or the equivalent 6.2V Zener diode.14 De-
sign and build a circuit with the Zener that will reduce a voltage from 12V to 6.2V. The current go-
ing through Rs should be limited to 15mA. What is the smallest load resistor that will not signifi-
cantly decrease the circuit output voltage? 
 
(G) Frequency Doubling 
Many nonlinear devices (including diodes) exhibit the very useful phenomenon of frequency dou-
bling; when driven by a sufficiently high amplitude signal, they double the signal’s frequency.15   
 

4.19 We will study frequency doubling in a Spice diode circuit. Go to a computer running 
Spice, and call up the BiasDiod schematic. 

 
The Spice circuit is very similar to the circuit in Fig. 2; capacitor C1 and resistor R2 are simply used 
to block the DC component of the signal across the diode. The parameter VAC sets the amplitude of 
the AC signal driving the diode, while V2 (1V) sets the DC bias. VAC can be changed by double click-
ing on the numeric value to its right, while V2 can be changed by double clicking on the number to 
its left. 
 
Set VAC to 0.00001. Here nonlinear effects are negligible. Run Spice, and look at the output. The 
graphics program (Probe) will pop up with a display of the input signal (at the amplitude 0.00001V) 
and the smaller output signal. As both waveforms look like perfect sine waves, it is difficult to de-
termine the purity of the waves directly from these plots. The best way to determine their spectral 
content is to find their Fourier representation. Use Window→Display Control to examine the 
Save/Restore Menu, and Restore the “Use this for FFT” display. The display will change to graphs of 
the Input and Output harmonic content. Both waves are nearly pure sine waves (Note the log verti-

                                                      
13 Make sure you switch from the Diode Tracer window to the Zener Diode Tracer window. 
14 The Zener diode spec sheet is posted on the web. 
15 Frequency doubling is frequently employed to produce short-wavelength coherent light. Few la-
sers laze in blue or shorter wavelengths. Powerful red lasers, however, are easy to build. The output 
from such  red lasers can be fed into a frequency doubling crystal…and blue light will come out. This 
blue light can then be fed into another crystal, yielding ultraviolet light. Although the process is 
lossy, frequency doubling is the most effective way of making intense, short-wavelength laser pulses. 
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cal scale.) The input sine wave does have some low level, white noise16 background that results from 
the numerics used in the Spice algorithm. The output waveform has some components near zero fre-
quency; these components are numeric artifacts that result from the finite time that the simulation 
is run. 
 
Now go back to the schematic and adjust VAC to 1V. Rerun the simulation, and note the gross dis-
tortion of the output wave. Look at the FFT display: in addition to the double frequency component, 
there is now a whole series of slowly decreasing higher harmonics. 
 
Play with VAC. What is the lowest amplitude input signal required for significant frequency dou-
bling? Are the harmonics ever stronger than the fundamental? Why do you think the frequency dou-
bling occurs? 
 
 

                                                      
16 Noise that is evenly distributed over all frequencies is called white noise.  Examples of white noise 
include the steady drone from a distant highway or waterfall. 
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Physics 111 ~ BSC Student Evaluation of Lab Write-Up 
 
Now that you have completed this lab, we would appreciate your comments.  Please take a few moments 
to answer the questions below, and feel free to add any other comments.  Since you have just finished the 
lab it is your critique that will be the most helpful.  Your thoughts and suggestions will help to change the 
lab and improve the experiments. 
 
Please be specific, use references, include corrections when possible, using both sides of this 
paper as needed, and turn this in with your lab report.  Thank you! 
 
Lab Number:    Lab Title:        Date:     
 
Which text(s) did you use? 
 
 
 
How was the write-up for this lab?  How could it be improved? 
 
 
 
 
 
How easily did you get started with the lab?  What sources of information were most/least helpful in get-
ting started?  Did the pre-lab questions help?  Did you need to go outside the course materials for assis-
tance?  What additional materials could you have used? 
 
 
 
 
 
 
What did you like and/or dislike about this lab? 
 
 
 
 
 
What advice would you give to a friend just starting this lab? 
 
 
 
 
 
The course materials are available over the internet. Do you (a) have access to them and (b) prefer to use 
them this way? What additional materials would you like to see on the web? 
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Appendix I  Diode Specifications 
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Appendix II Curve Tracer Operation 
 
Curve tracers are versatile instruments that characterize a wide variety of electronic components.  
Commercial curve tracers cost upwards of $30,000. We will use a homemade, computer-based curve 
tracer that has a few advantages over commercial units.17 The Curve Tracer consists of a circuit that 
provides appropriate biases to the device leads and measures the currents into the leads, an analog 
to digital computer converter card, and a LabVIEW virtual instrument program that controls the 
biasing hardware and collects the resulting data. LabVIEW is an unusual programming environ-
ment that is superb for computerized data acquisition tasks. 
 
Note that help for many of the controls can be obtained by typing ^H. 
 
If the Curve Tracer is not already running, start it 
by double clicking on the Curve Tracer icon. The 
main selection window will appear, as shown to the 
right, from which you pick the device type to be ana-
lyzed. 
 
If the main selection window is visible, but not run-
ning, it will look like this: 

 
 
 

Restart it by pushing the go arrow:  Once the 
main selection window is running, select and start 
the Diode Tracer. The Diode Tracer window will 
appear as shown below. 
 
 
 
 

Attach your diode to the input connections (the pro-
gram will tell you how to connect the diode – anode 
to drain/collector and diode to source/emitter), 
and press the Get Characteristic Data button. The 
Curve Tracer will acquire and plot the diode charac-
teristic. The saturation current and voltage coeffi-
cient in Eq. 1 can be obtained by pressing the Ana-
lyze Data button. When the Analyze Data button 
is pushed, LabVIEW fits an exponential of the form 
AeBx to the data using least squares method. Calcu-
lated A & B correspond to isat & the voltage coeffi-
cient, respectively. The data can also be saved to a 
file and printed by pressing the appropriate buttons.   
 

                                                      
17 Our curve tracer is simpler to use and more accurate at lower currents than most commercial 
units, and can also calculate parameters like the saturation current automatically.  Its major disad-
vantage is that it takes data relatively slowly. 
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Toggling the Clear Previous Data button to Keep Previous Data will overlay additional charac-
teristic traces over the initial trace. This option can be used to compare the curves for different de-
vices. 
 
Some additional information about the Curve Tracer is available on the BSC Web Site. 
 

Appendix III Excel Tutorial 
 

Although this tutorial is meant to be a general introduction on how to use Excel to plot your data, we 
will use the load line analysis in Lab 4 (Diodes) as a specific example and go through the procedure 
step by step. In this document, an expression such as “Menu”→“Command” implies click on the 
menu item on the top (such as File, Edit, View, etc.) and select a command from the submenu (such 
as Open, Copy, Paste, etc.). 
 
First let’s talk about how to get the data into Excel. You will notice that Labview saves your diode 
characteristic curve in .dat format. This file is a standard text file (ASCII) that you can open with 
any text editor such as Notepad. Excel is also capable of importing ascii files. In Excel, go to 
File→Open. This will bring up the Open File dialog box. Go to the directory your file is in and click 
on the .dat file (we’ll call the file diode.dat from now on). You may not be able to find diode.dat 
unless “Files of type” is not set to “All Files”. This may or may not bring up the “Text Import Wizard” 
depending on the version of Excel you are using. If it does, follow the directions of the wizard, but 
most likely clicking “Finish” will import the data correctly. If the data has been imported correctly, 
you will see two columns of numbers with the first row of each column reading “Voltage (V)” and  
“Current (A)”. (See figure below.) 

 

Chart Wizard Icon

Formula Bar
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We now have the diode characteristic curve. What we need to do next is to generate the data for the 
load line: we want to create a new column of currents where I(V) = (Vo – V)/R (remember that Vo is 
the offset adder voltage and R is the resistor value in Ohms). As an example, let’s assume that the 
offset adder voltage is 1V and R = 1k. Click on the cell located at Column3, Row 2 (C2). Type the fol-
lowing into the formula bar (you must type the = sign): 

=(1–[click on Column1, Row2])/1000 

If your columns are labeled by A, B, C, etc., then the expression should look like: 
=(1–A2)/1000 

When you press enter, a numerical value will appear in the cell at C2. There is an easy way to gen-
erate the rest of the currents for the load line. Notice that when you click on C2, the cell is sur-
rounded by a box with a little square on the lower right hand corner. Click, hold, and drag the 
square to the row where the data ends (probably around row 70). This will automatically generate 
all the I values for the given V values in the first column. 
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Now that we have the data, we want to plot both the diode curve and the load line on the same plot 
to find the intersection. Highlight the first two columns from Row2 to the end of the data (i.e. do not 
highlight the title of each column) and click on the “Chart Wizard” Icon, or alternatively,  
Insert→Chart. This will bring up the Chart Wizard. Select “XY (Scatter)” from the “standard Types” 
and select “Chart sub-type” that has the data points connected without markers. (See figure above.) 
Click “Next” which brings you to the Chart Source Data dialog box. Click on the “Series” tab. You 
will see that there is only one series called “Series 1” corresponding to the diode curve. Add a new 
series by clicking “Add”. The x values should be the same so, click on “Series 1” and highlight its “X 
Values” and Edit→Copy. Click on “X Values” of “Series 2” and Edit→Paste. The “Y Values” should be 
the data in column 3. You can mimic the style and just type it in (notice that it designates the range 
by $the initial row $the initial column: $the final row $the final column) or by clicking on the up red 
arrow icon on the right side of the “Y Values” box which minimizes the chart wizard box allowing 
you to highlight Column3 from Row2 to ending row. Once you have highlighted it, click on the down 
red arrow to maximize the Chart Wizard where the proper range should be entered in to the “Y Val-
ues” box. You will notice that a second line with a different color is added to the plot. Now, you can 
either click “Finish to exit the Chart Wizard or continue clicking “Next” to embellish your plot with 
titles, etc. However, once you are done, you’ll see that a plot of the data is embedded into your work-
sheet. 

 

You might have to rescale the plot to find the intersection point. To rescale the y-axis, for example, 
double click on any of the y values which will bring up the “Format Axis” dialog box. Go to the 
“Scale” tab and play around with the maximum value plotted, etc. to rescale. You can use this 
method to plot multiple load lines by adding additional series. 
 

Click this icon to highlight
the 3  columnrd


